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FOREWORD INFORMATION 

NOTICE 

RASplus software is free of charge and is distributed as a content of Novus NDR-HA series 
package. Number of installation for DVR owner is not limited. 

 

1. FOREWORD INFORMATION 

NDR-HA1000, NDR-HA2000, NDR-HA4000, NDR-HA5000, NDR-HA6000 series DVRs feature 
certain advanced solutions including network client software - RASplus capabilities. The software 

described in this manual allows users to manage one DVR as well multi-DVRs system effectively. 
Live view and recordings search are also possible. Additionally remote setup of DVR can be done. 
Both software and DVR are password protected what prevents unauthorized access.   
 

ATTENTION: It is strongly advised to read this manual before starting RASplus operation.  
 This manual often refers to DVR features. Detailed information about DVR features 
 are available in its manual. 

 

1.1   Main characteristic 

·   Intuitive, graphic user interface (GUI) composed of 12 separate panels for specific functions 

·  Simultaneous multi-site connection  

·  Simultaneous multi-user connection: up to 10 users in Watch mode, up to 2 users in Search mode, 
 up to 2 users in Admin mode  connected to one DVR 

·  Local recording feature 

·  Remote DVR setup feature 

·  Automatic Emergency Event notification  

·  Site maps feature 

·  Remote PTZ feature 
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1.2   Software installation  
 
 

 
 
Attention: Previous RASplus software should be uninstalled before new version installation. 
 
In order to start software installation find RASplus link on the CD that accompanies the DVR.  
After double clicking RASplus link software installation process begins . 
 
When the following window appears click Next. 
 
 
 
 
 
 
 
 
 
 
 
 

Processor Intel® Core 2 Duo 3GHz,  

RAM Memory 2GB 

HDD 52MB for software files, and additional for local backup and recording 

Other hardware VGA graphics card, 256MB  
Network card 10/100BaseT 

OS Microsoft® Windows XP™, Windows Vista or Windows 7. 

Minimum hardware and system requirements for proper software support 

FOREWORD INFORMATION 
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Next step allows for selecting the installation destination folder. Default c:/RASplus location may be 
changed if needed. To change path, please select the Browse button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Selecting Disk Cost  displays the list of available disks: 
 
 
 
 
 
 
 
 
 
 
 
First column contains letters of available disks. Next column contains information on their capacity. 
Available column indicates free space available on particular disks. Required indicates space required 
for succesfulRASplus installation. Next column presents an estimated free disk space left after 
successful software installation. Clicking OK closes the window. 
Additionally, window features the possibility of assigning an account that the software will be 
associated with. Selecting Everyone installs the software for any user. Selecting Just me associates 
the software with a currently logged-in user.   

FOREWORD INFORMATION 
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Pressing Next displays the following installer window: 
 
 
 
 
 
 
 
 
 
 
 
 
 
Checking Automaticaly run RASplus when I log on to Windows adds a registry entry running the 
software automatically immediately after a user logs into Windows system.  
Pressing Next installs the software at a desired location. Progress is represented by a blue bar. 
Selecting language is the final step of installation. Enabling language selection after each restart is 
performed by checking Select language when starting RASplus and pressing OK)  

For one-time selection of a default language please check the Always start RASplus using the 
language below, select a language from a list and press OK. Proper software operation requires 
XTML support. Setup file includes XHTML Parser 4.0. Once application installation ends, info 
window is displayed. 

 

 

 

 

 

 

 

 

 

Depending  on component presence in the system installation should be either carried out or aborted. 
In order to check for the component’s presence please enter Add or Remove Programs menu in 
Control panel. Check if the MSXML x.x position is present on the list. 
 

FOREWORD INFORMATION 
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If the component (minimum version 4.0) is already installed in the system, please de-select Install 
MSXML in the install window and press the Finish button. 
If the component is not installed or its version number is lower than 4.0 please select Install MSXML 
and press Finish button, starting component’s installation. 
After appearance of the window, depicted below, select Next 
 
 
 
 
 
 
 
 
 
 
 
 
 
Next, please check the I accept the terms in the License Agreement and press the Next button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Enter the User name and Organisation and press Next. 

FOREWORD INFORMATION 
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After the appearance of a window depicted below please select Install Now and press Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Finally, after the next MSXML installer window appears, please select Finish. Please select Close in 
the RASplus installer window. The installation is now complete.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In order to uninstall RASplus software please enter the Programs and select Unistall RASplus  in the 
RASplus position. Settings folder requires manual removing after a successful uninstall. 

FOREWORD INFORMATION 
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1.3 Software start-up 

RASplus can be started using the following icon placed on the desktop or in Programs  menu. 
 
 
 
 
After a while application window appears on the screen. 
After first software run panel layout is set to default. During normal operation users are able to adjust  
the layout for their own needs. 
 
There is no login required while first start-up.  
 
Screen resolution 1024x768 or higher and 24 bit colour depth is recommended.  
In case of improper VGA settings appropriate information is displayed.  
 
Using certain VGA cards a multi-screen display mode is possible. In such case many panels can be 
viewed simultaneously without interfering each other.  

Refreshing rate during connection depends on: 

- PC<-->DVR connection bandwidth  
- DVR settings, bandwidth and quality of data stream can be adjusted 
- number of simultaneously connected sites (the more sites connected the lower each connection 
 refresh rate is)  
- number of clients simultaneously connected to particular DVR (the more users connected the lower 
 refresh rate from that DVR is) 
- recording speed carried out by DVR at the moment of connection, local recording (as well archiving 
 and playback) has higher priority than networking so transmission speed might be decreased in that 
 case 
- in search mode refresh rate might subjectively fall when high recording speed data is being sent, all 
 stored images are being sent in the search mode, that’s why DVR, for example,  has to send 12 
 images for each second of recordings which might noticeable decrease refresh rate especially while 
 narrow bandwidth line is used. 
 
Following simultaneous connections to one DVR are possible: 
-  up to 10 users in Watch mode (live view) 
-  up to 2 users in Search mode 
-  up to 2 users in Admin mode (Status view, DVR registry view, remote DVR setup, live view by 
 means of site maps) 
 

FOREWORD INFORMATION 
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2. SOFTWARE PANEL MANAGEMENT 

2.1. GUI description 

GUI is divided into sections whose function is described below. Part of GUI is composed of movable 
panels. Detailed information about each panel can be found in the following chapters of this manual. 
Panel moving and hiding is a characteristic feature of RASplus software. You can find default GUI 
layout available after first software start-up below.  

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Function icons might be displayed or not depending on Main Toolbar under View menu settings. 

SOFTWARE PANEL MANAGEMENT 

Emergency Event 
View, Watch Event 
View, Report View 

Panels 

Search Panel 
Map, Colour control ,  

PTZ Control , Alarm Out and 
Image Processing panels 

DVR Status Panel 
Camera Display 

Panel 
Program menu Toolbars 

Remote Sites  
and Favourite Sites 

Panels 
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2.2 User workspace arrangement  

As mentioned before, GUI is composed of movable panels. Panels may be enabled and disabled, 
merged and separated, as well as have their size and position adjusted. Multi-screen display for GUI 
split  is also possible (VGA card must support that mode). 
Abovementioned possibilities provide almost unlimited workspace arrangement capability. Thanks to 
that, user’s workspace might fit all his preferences and requirements. User GUI layout is stored and 
recalled after program restart.  
In this manual, Panel word refers to movable and scalable rectangle window. 
12 separate panels can be distinguished in RASplus software: 
- Remote Sites Panel 
- Favourite Sites Panel 
- Colour Control Panel 
- PTZ Control Panel 
- Alarm Out Control Panel 
- Image Processing Panel 
- Search Panel 
- Emergency Event Panel 
- Watch Event Panel 
- Report View Panel 
- DVR Status Panel 
- Map Panel 

After software installation panels are divided into 3 groups by default:  
1. Remote Sites Panel + Favourite Sites Panel 
2. Colour Control Panel + PTZ Control Panel + Alarm Out Control Panel + Image Processing Panel + 

Map Panel 
3. Emergency Event Panel + Watch Event Panel + Report View Panel 

Each panel has title bar on its top, together with 1 or 2 icons. Normally, title bar is grey and changes to 
blue (or any other colour set for active windows) right after clicking on the window. Blue bar means 
that the panel is active and its size and position might be changed.  
 
 
 
 
 
 
 

 

 

 

 

Following pages of this manual describe the principles of panel management. Although the examples 
are presented only for certain panels, the rules refer to all of them. 

Icon Bar 

SOFTWARE PANEL MANAGEMENT 
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2.2.1 Panel moving 

Each of the 12 panels may be moved to a desired point of GUI including moving out to secondary 
screen (if VGA card supports multi-screen mode). In order to move the panel, click the left mouse 
button on the panel bar, keep the button pressed and move the panel to a desired point.  

 
 
 
 
 
 
 
 
 

 

 

Notice: Camera image window cannot be moved.  

 

2.2.2 Changing the panel size 

In order to change the size of any panel please move the mouse cursor over the panel edge so that 
cursor changes the appearance to a double arrow. Depending on the edge, horizontal or vertical size 
may be changed. Holding left mouse button down changes the size of the panel. In order to 
simultaneously change both panel dimensions, move the cursor to the lower panel corner and follow 
the instructions above.  

 

 

 

 

 

 

 

 

 

 

 

Notice: Camera image window size cannot be changed in the described way. The size of that window 
is automatically adjusted depending on other windows size. 

SOFTWARE PANEL MANAGEMENT 

Cursor shape while 
panel size changing 
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2.2.3 Panel docking  

Each of the 12 panels can be placed in any GUI point. The arrangement could be completely                
“chaotic”, however, in most cases users prefer an orderly and optimal workspace utilization. In order 
to ease panel arranging, RASplus software supports panel docking system. It helps user to easily 
dock panels with pixel accuracy. 

 

 

 

 

 

 

 

 

 

In order to dock the edge of the panel to the edge of another “drag” the panel as described in chapter 
2.2.1, keep the mouse button pressed and move the panel above the base panel area. Docking buttons 
(cross-shaped) menu is displayed.   

Workspace automatically arranged by precise 
panel docking system  

Manually arranged workspace.  
No panel docking system was used. 

Base panel Panel docking menu 

Docking panel 

SOFTWARE PANEL MANAGEMENT 
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When mouse cursor moves over the docking menu, blue area appears depicting future position of 
docked panel. After mouse button is released panels are docked. Below you can find the stages of 
docking the Emergency Event View panel to the lower edge of Remote Sites Panel. 

 

 

 

 

 

 

 

 

 

 

  

You can find the description of each part’s docking menu below. 
 
 
 
 

 

 

 

 

 

 

 

 

 

Docking to the edges of the camera image window is performed in a similar way. In this case panel 
should be “carried” over a window area. 

Docking to the edge of the whole software window is also possible. In this case panel should be 
“carried” to the edge of the screen where one of the icons presented above is displayed 

Docking to the right edge  
of  a panel 

Docking to the left edge  
of  a panel 

Docking to the lower edge  
of  a panel 

Docking to the upper edge  
of  a panel 

Docking stage Final stage - 2 panels docked (to each other) 

SOFTWARE PANEL MANAGEMENT 
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2.2.4 Panel joining 

Each panel can be displayed separately or as a group of joined panels. As you can see in chapter 2.1 
panel created from a few separate ones is a default way of appearance for: 

1. Remote Sites Panel + Favourite Site Panel 
2. Colour Control Panel + PTZ Control Panel + Alarm Out Control Panel + Image Processing 

Panel + Map Panel 
3. Emergency Event Panel + Watch Event Panel + Report View Panel 

In order to select particular elements of a joined panel use panel tab shown in the lower part of multi-
panel.  

 

 

 

 

 

 
 
 
 
 
 

 

 

Notice: Camera image window cannot be combined with any other panel.  

In order to join two panels into one multi-panel “drag” the panel bar as it was described in chapter 
2.2.1, keep the button pressed and move cursor over base panel. Like it has been described before, 
cross-like menu appears.  

This time move the cursor right over the icon located in the cross center. 

 

Panel joining 

SOFTWARE PANEL MANAGEMENT 

Panel selecting tabs 
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At the moment the cursor moves over the centre of the joining menu, the panel that has moved 
disappears and appears as a new tab on the bottom of target panel(s).  

 

 

 

 

 

 
 
 
 
 
 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

Tabs order may be rearranged by clicking on any tab and moving it with mouse button pressed.  

Any joined panel can be separated from others in a similar way. Click on a desired panel tab, keep the 
button pressed and move the panel away from the present panel. 

  

Panel joining - 1st stage Panel joining - 2nd stage 

Target panels Joined panel Added panel tab 

Panel joining - final stage 

SOFTWARE PANEL MANAGEMENT 
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2.2.5 Panel closing 

Each panel can be easily closed using an X-shaped icon in the upper right corner of the panel.  

 

 

 

 

 

 

In case of complex panels all component panels are closed when this method is used. 

In order to display a closed panel go to the View menu and select a desired panel. In this case only one 
panel is restored. In order to restore a complex panel all the components should be restored one by one 
and joining should be carried out again.  

2.2.6 Panel auto hiding feature 

RASplus software supports auto hiding feature. This feature allows to utilize workspace for camera 
image displaying very effectively and to maintain fast access to each hidden panel. 

When this option is enabled, a particular panel is visible only when mouse cursor is above it. Once 
cursor is moved out panel is automatically hiding in right, left or bottom edge of RASplus window 
and only panel tab is displayed.   

All the panels constituting a joined panel are displayed as separate tabs. Therefore, a situation may 
develop that not all tabs can be displayed because of lack of the space. In this case special arrow-like 
icons appear by means of which user is able to toggle between all tabs of given panel.   

Panel closing icon 

SOFTWARE PANEL MANAGEMENT 
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The view of the software window after enabling auto hiding feature for all panels 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
The same window after  selecting search panel tab  

 

  

Hidden panels’ 
tabs 

Icon scroll tab 

SOFTWARE PANEL MANAGEMENT 
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2.2.7 Loading the panel layout 

RASplus software allows for convenient loading the pre-set panel layout called Layout. After 
clicking the     icon or selecting Frame Layout/ Load Layout in the Layout menu, the following 
Layout selection menu is displayed: 

 

 

 

 

 

 

 

 

 

First layout - Default Layout allows for restoring the default panel layout settings. Three subsequent 
panel layouts are designed to fit the three most common operator actions. Their purpose is explained 
in their names: Admin Layout, Full Layout, Hide Layout. Gray rectangle represents the camera 
view window. After selecting User Defined Layout loading an own panel layout becomes available. 
To fit the panel size to a selected layout, please  confirm the selection by clicking Load. Clicking 
Cancel closes the window without changing the panel layout. 

2.2.8 Saving the panel layout 

After clicking the  icon or selecting Frame Layout/ Layout Setup in the Layout menu a menu 
allowing for saving the Layout appears. 

 

  

SOFTWARE PANEL MANAGEMENT 
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The first menu part allows for setting the default layout loaded during the software start-up. After 
selecting the “Always load Layout at RASPlus startup” the Layout list becomes active, allowing 
for selection of a pre-defined layout, which is in turn displayed after each software start-up. To save a 
personalized layout, please enable and arrange desired panels. Then, after entering the layout save 
menu please name a layout in the New Layout menu and press the Save.                        
After selecting a layout name from the layout list and pressing Rename layout title edition becomes 
available.                

Selecting a layout name from the layout list and pressing Delete deletes the layout.                                                                                                          

To apply changes performed in any position please select OK. Pressing Cancel leaves the menu 
without saving. 
 

 

  

SOFTWARE PANEL MANAGEMENT 
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3. SETTINGS 

3.1 System setup 

In order to enter the system setup click         icon or enter System / Setup. This menu consist of 5 
tabs where all program settings are gathered. 
In order to save changes done in each tab click OK. Clicking Cancel closes the window without 
saving changes.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.1.1 System 1 tab 

· In Date / time Format current date and time of system clock is displayed. You can change the  
date (day, month, year) and time (12h, 24h) display format in this menu. 

SETTINGS 
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· Display option section sets the display mode for cameras. 

 Screen Option allows for setting whether auto-connection to a given location or camera (by 
 "dragging and dropping" location/camera name on a display window) occurs in “live” (Watch 
 Screen selected), playback/search (Search Screen selected) or via context menu forcing 
 mode selection on every launch. (Watch Screen and Search selected).  

 Hide the message box allows for enabling/disabling displaying connection status information,  
 i.e.: Connection timeout, Logout etc. Example: 

 

 Drag&drop Popup Options sets whether the context menu (with Watch Screen and Search 
 box checked) should be displayed only during dragging and pressing the LMB (Use Left 
 Mouse Button selected), only during dragging and pressing the RMB (Use Right Mouse 
 Button selected) or displayed regardless of the button pressed during dragging (both options 
 selected). 

· Drawing mode setup allows to adjust the display to the capabilities of available VGA card.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Third section is responsible for default video filter settings as well as picture ratios. 
Deinterlacing enhances moving objects using full PAL (720x576). 6 filters are available. 
Aspect ratio allows for setting camera display mode. 
 Fit to screen fits the displayed image to the window size regardless of its proportions.  
 Original Ratio forces the 4:3 picture ratio without deforming it. May force certain parts of the 
 display window to turn black. 
Antialiasing enhances the display of  oblique edges. 

SETTINGS 
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· The OSD Setup menu... allows to change on screen display information such as: 

 Title - camera name displayed in live watch and search mode 
 Time Info - time displaying in live watch and search mode 
 Date Info - date displaying in live watch and search mode 
 Text-in - displays text data both in live and playback modes  
 Overlay Text-in Data  - adds text data to a backup file  
· The Recording Setup section allows to set local panic recording parameters. Panic recording is 

triggered manually by user and allows to record first 16 channels on PC HDD.   

 Use Recording - tick / un-check this option for enabling / disabling panic recording feature 
 Overwrite - tick / un-check this option for enabling / disabling overwriting assigned HDD 
 space 
 Recording mode setup - allows for setting the recorded channels. 
 Visible watch camera - Enabling it results in recording first 16 active cameras (after activating 
 the recording). Recording is indicated by the red R letter located in the upper part of the image. 
 User Assignment Setup allows for manually setting which 16 of the 64 video channels 
 available are recorded after activating the panic recording function. Channel is picked by 
 pressing the RMB on the picture and selecting Camera recording Setup from the pop-up 
 menu. A grey R letter appears in the top left corner of the window, which will turn red  in case 
 of recording. 
 Camera Range Setup allows for manually setting the range of cameras (out of the 64  v i d e o
 channels) that are recorded after starting the panic recording.   
 Recording Folder Path - currently valid recording folder, to be changed after clicking the 
 button marked three dots. New folder can be created in selected destination. In order to accept 
 changes OK button should be clicked, after clicking Cancel, the menu is closed without saving 
 any changes. 
 Size (MB) - HDD space assigned for panic recording. In order to changing the size uncheck   
 Use Recording, close and enter Setup menu again, then using arrow buttons set desired value. 
 Minimal size is 640 MB, maximum value is 2048 MB. Keep in mind that HDD space is shared 
 with other applications and operating system installed on PC. 

SETTINGS 



Instrukcja obs
ugi oprogramowania sieciowego Multi-Viewer 2.54 . Wersja 1.0. 
 

RASplus - User’s manual ver. 2.3. 

All rights reserved © AAT Holding  Sp. z o.o.   
 

25 
 

3.1.2 System 2 tab 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

· In the Dial-up Network section ISDN modem can be selected 

· In the Security Option section password options can be set. 
 If Before Setup is checked password dialog box is displayed when Setup menu is entered. If 
 you  select Before Startup password dialog box is displayed when software is started. If 
 Before Shutdown is checked password dialog box is displayed when software is closed. 
 Each option can  be selected independently and any combination of three is possible. 

SETTINGS 



Instrukcja obs
ugi oprogramowania sieciowego Multi-Viewer 2.54 . Wersja 1.0. 
 

RASplus - User’s manual ver. 2.3. 

All rights reserved © AAT Holding  Sp. z o.o.   
 

26 
 

 No password is required by default.   
 If at least one of the mentioned password options is checked the following dialog box appears                
 in appropriate situation 
 
 
 
 
 
 
 
 
 
 No password is set by default (blank field left) 
 After clicking Change... button the following menu appears 
 
 
 
 
 
 
 
 
 
 
 
 In the first field current password should be typed in (blank if no password is set). In the next 
two fields new password should be typed in twice (for confirmation) 

· Network Option allows to change call-back port number (Callback IP Port Number). 

· In the Report Setup section automatic reporting feature setting can be done. In order to 
activate this feature tick Use Report. Once it is active Report Check Interval can be set from 
1 to 24 hours. 

· The DVR Name Service section allows to set domain name service server address and port 
number. 
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 Count of Emergency Event to display sets the range (10~1000) of events displayed on the 
 list. After exceeding upper limit, older entries are replaced by newer ones. 

 Event Sound Setup defines which events are to be signalled by a buzzer.  For each event user 
 may set  if the buzzer is activated for watch (Watch),  alarm (Emergency),  both event  types or 
not at all. 

 Sound Path allows for selecting a .wav file that will be played if an event occurs. 
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3.1.3 Remote Sites tab 

Site describes DVR connected to the network, its name, and network settings (address, port numbers 
etc.)  
The following menu appears when Remote Sites tab is selected 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the left menu section defined site groups and sites are listed. Using site groups helps to manage 
large site numbers. 
By default, only one group - RemoteSites is defined. 
In the right menu section selected group content sites are listed.  List all option on the lower part of 
the window allows to list all the defined sites. When you have larger number of sites Find feature 
might be helpful. The whole site name or only part of the name can be searched.  
In order to define a new group or site Add button should be clicked. 
In order to change already defined site settings click Change. 
In order to delete already defined site click Remove. 
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After clicking Add, the following menu window appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
· In the Reference Group section a new site group may be selected or added (Add…) 
· Device Setup sets the type of a device; DVR. 
· In the Remote Site Setup section site parameters may be set.  
  Site Name - any site name e.g. Novus 
  IP Address - DVR IP address 
  Port... - port setting menu (range 8000~12000), each port for a specific function:  
  Admin - control, status, report, Watch - live video stream, Search - recordings playback  
  stream, Audio - audio stream transmission (available only for selected DVR models) 
  Use modem - select when modem-to-modem connection should be established 
  Phone Number - target phone number while modem-to-modem connection 
  Use DVRNS (DVR Name Service) - enabling / disabling domain name service 
  DVR Name - domain name used instead of IP address when DNS feature is enable 
  PC-Based DVR - please check the box only if a DVR is basing on a    video capture 
card. 
· In the Login Setup section user account settings can be done.  
  User ID 
  Password  
  Confirm Password  
  When no password is required for connection tick the No Password item. 

· Emergency Event Instruction; please enter the message that will be displayed in Emergency 
Layout  panel after detecting an alarm.  

  Account settings should be the same as the account settings saved in DVR menu. 

Notice: User specified in the site settings menu refers to the user specified in the DVR menu. 
 For that reason remote user has exactly the same rights as local user. The above fact
 may cause disabling certain functions described in this manual. 

SETTINGS 
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3.1.4 Favourite Sites tab  

Users can arrange and save their own camera layout as well as add it to favourite views. Favourite 
camera layout may consist of cameras from different DVRs and different modes (live view and 
search). User view feature allows for quick and easy connection to more than one DVR in one click. 

After clicking Favourite Sites, the following menu appears. 

 
· In order to create new camera layout click Add and give a desired name and select one of 10 

camera layouts available. After clicking OK that name appears in the Site Name field. On the 
left in the Group List section all defined sites are listed. 64 windows are displayed to the right, 
with each being able to be assigned to a different camera. 
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  In order to assign any “live” camera feed to any window, please find camera name on the list (it 
might be necessary to expand the list), click the left mouse button on it, keep the button pressed 
and drag the name over the desired window. After the button is released DVR and camera 
names appear in the window. In order to assign all cameras from particular site in one move 
DVR name, instead of single camera name, should be dragged and dropped. Cameras are 
assigned one after another to consecutive windows.  

  In order to assign cameras in the search mode similar action should be done but the right mouse 
button should be used. After the button is released the context menu appears. This time the 
Search option should be chosen. 

  Camera mode in favourite layout is indicated by a letter in square bracket before camera name.  
The example from the previous page shows only live view cameras assigned to each window 
[W]. 

  In order to remove assignment select desired window (marked with red frame) and click 
Remove Selected Camera. By using the Ctrl key from PC keyboard more than one selection 
can be done. 

  In order to remove all assignments click Remove All Cameras.  

  Camera view can be saved as a favourite one during normal connection. In order to do that the 
following icon       should be clicked and then layout name should be typed in.   

· In order to change camera assignment in existing layout select its name on the Site Name list 
and click Change. Then follow steps described above for new favourite site creating. 

· In order to remove saved favourite view select its name on the Site Name list and click 
Remove.  
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3.1.5 Sequence Sites tab 

RASplus software allows for sequential connecting to selected sites for defined period of time. When 
the following icon       from main window menu is “pressed”, auto switching mode is enabled.  
 
The following menu appears after clicking the Sequence Site tab. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the left menu section defined site groups and sites are listed. In order to add sites to sequence click 
Add. Site name appears on the right in the Auto sequencing list. Favourite view can be also added to 
the auto sequence list. In order to add all available sites to auto sequence list click Add All.  
Adding a personal camera layout to the sequence is also possible. 
In order to delete already added site click Remove. In order to delete all sites from the list click 
Remove All 
In Sequence Dwell Time Section time period for connection with each site measured in seconds is 
defined.  
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3.2 DVR firmware and setup management 

RASplus allows users to remotely manage DVR firmware and setup. After selecting System / Batch 
Job Setup, the following menu appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Menu window consists of 2 tabs. 

 

3.2.1 Upgrade Tab 

Upgrade is used for remote firmware upgrade for unlimited numbers of DVRs at a time. Site 
selecting and removing is similar to Sequence Sites feature described on the previous page. In order 
to start upgrade process Upgrade Now button should be clicked. 
Dialog box appears. User should select desired firmware file (*.rui). Then the OK button should be 
clicked to start upgrade procedure. 
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Notice: Upgrade procedure does not delete DVR settings and recordings. 

Warning: Upgrade procedure does stop recording for at least 8 minutes. 
 
3.3.2. Setup tab 
The second tab (Setup) allows to remotely load DVR menu settings. Site selecting and removing is 
similar to Sequence Sites feature described earlier. Settings can be loaded only for one DVR at a 
time. In order to start settings upgrade process the Setup Now button should be clicked. 
Dialog box appears. User should select desired firmware file (*.cfg). Then the OK button should be 
clicked to start upgrade procedure. 
 
 
 
 
 
 
 
 
 
 
Warning: Before uploading the settings to the DVR make sure that the uploaded file has been 
downloaded together with the network settings. If so, make sure that these settings are identical with 
those currently used in DVR. Otherwise once the settings are uploaded, the DVR will not be 
accessible with the help of RASplus software under the predefined name. 
 In such a case reconnection can be established only when new settings are input into System / 
Remote Sites for that DVR (see chapter 3.1.3) 
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3.3 Software log management 

RASplus software has a complex and effective log system. As well software events, user activities 
and callback connections are stored in software log file. Software log consists of 3 modules: 

- system registry (user activity recordings) 
- event log (contains callback events sent by recorders to the client software) 
- DVR management log (refers to remote DVR upgrades and setup)  
Log file can contain up to 5000 entries (events list pages can be changed by means of slider placed in 
right part of the window). In order to avoid entries overwriting file saving or printing feature can be 
used.   
System log file can be filtered for display using date and event type as a condition. 

In order to enter log view menu one of the following icon    should be clicked 
or Log  items from the System menu should be selected. 
After a short while, the Log Viewer window appears on the screen: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Left part of the window contains the complete list of software registries. Clicking on a particular 
position displays the contents of selected registry. Clicking the Przegl� d wpisów rejestrów in the 
right part of the window displays the number of events stored in particular registries. 

SOFTWARE LOG 
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3.3.1 System Log 

Clicking System displays system log contents. Bottom right part of the window displays information 
on an event. Each event is described by the following parameters, grouped in columns: 

- Event - Type (name) of an event 

- Site - name of the location associated with that event 

- Connect Mode - In case of „establishing a connection” event this column contains information on 
mode of the connection. 

-  Data - Date and time of an event’s occurrence, based on the system clock. 

By default, all registered events are displayed. Simultaneously, a search filter is activated in the top 
right part of the window, allowing for narrowing the search criteria.  

First part of the filter allows for defining the time interval that the events will be selected from. 

After selecting Current Time from Search Time and additionally 1 of the 7 positions in the 
subsequent row, it is possible to display all events from the system log that happened at any time or, 
subsequently, from today, last 3 days, last week, month, 3 months or 6 months. 

Selecting Detail Time from Search Time allows for precise setting of the time intervals. 

To display events meeting filter requirements please click Search.  

To remove filter parameters please select Remove.  

Second part of the filter allows for, apart from the time of occurrence, setting priorities for event 
types. Detail condition is the function responsible for this.  

By default, only the first line allowing for setting the search parameters for 3 positions is available. 
First position allows for selecting search criterion from the drop-down list. Searching only particular 
events, events associated with particular locations or events describing connection mode is available 
here.  

Second line allows for selecting one of 28 events, if searching for events, entering the location’s title 
if searching for a location, or selecting one of three connection modes if searching for mode.   

Third line allows for selecting logical operators that will be used as a connective between two 
parameters during database search:   

==    - Only the entries meeting the parameter exactly are displayed. 

!=   - Only the entries not meeting the parameter exactly are displayed. This is the opposite of the  
  first operator. 

like   - As first operator, but not case-sensitive.  

SOFTWARE LOG 
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Not like   - The opposite of the previous operator. 

<  - „Less than” parameter - displays only entries whose values meet the requirement, with digits 
being less „valuable” than letters. 

<=  - „Less than or equal” parameter 

>  - „More than” parameter 

>=  - „More than or equal” parameter 

Filtering the events using more than one filter at a time is possible. To activate second (and 
subsequent) filters please select Add Condition. Additional line allowing for entering another 
condition is then displayed. Usage of logical OR or AND criteria is possible.  
The example below allows for displaying only events informing on remote DVR setup, model 5500, 
that occurred last month. 
 

 This example shows the criteria that should be used when searching for entries informing on 
connections established in order to search the 5500/5100 DVRs for records, during last month. 
 
To remove particular search criteria please click Remove to the right of a given condition. 

SOFTWARE LOG 
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3.3.2 System registry 

 
In case of remaining 4 registry sections similar filtering and displaying rules are applicable, the only 
difference being separate criteria displayed for each section.  
The Check Emergency date and time available in the second column indicate the moment of an 
operator’s reaction, i.e. the moment of connection („dragging” the entry over the camera picture 
window) with a particular location after an event’s occurrence. Date and time in the fifth column 
indicate the moment of an event occurrence. Difference between second and fifth column  indicate the 
reaction time. First column depicts connection mode used for event verification. „Eye” icon indicates 
„live” viewing. „Magnifying glass” indicates that the recording associated with an event has been 
already watched. 
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3.3.3 Log file saving, opening and printing 

As it has been mentioned before log file can be saved in one of three formats. After selecting desired 
log window enter the File menu and use Save as... option. Then name, format and target path should 
be specified. The following file formats are available: 

- TXT - ordinary text file, can be reviewed using any text  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- CSV - (Comma Separated Values) file can be opened and viewed by means of Excel software for 
example. 
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- RPL - own format of RASPlus software, can be opened only with this software.  

Filtering and entry display is available after file opening with the software.  

In order to open previously saved log file enter the File menu and use the Log File Open feature. 
Previously saved events are displayed the same way as it was described in the previous sections of this 
chapter. All filtering features are also available. If you close the log window and opening it again 
displays current events.  

After entering the File menu and selecting the Print option log file content can be printed out on 
system printer. Example printout view is presented below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

SOFTWARE LOG 



Instrukcja obs
ugi oprogramowania sieciowego Multi-Viewer 2.54 . Wersja 1.0. 
 

RASplus - User’s manual ver. 2.3. 

All rights reserved © AAT Holding  Sp. z o.o.   
 

41 
 

3.3.4 Erasing registry contents  

RASplus allows for selective removal of registry contents.  

NOTE: Prior to removal operation please prepare a back-up copy of the registry in order to restore it 
when necessity arises. 

To remove registry or its particular sections please enter File and select Delete Log.  

 

 

 

 

 

 

 

 

 

Selecting Delete the log older than allows for defining timeframe for the deletion. Target Log 
allows for deciding whether all sections of the registry are to be deleted or only particular ones. 
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4. LIVE WATCH MODE 

4.1 Live view 

RASplus software allows for simultaneous display of up to 64 cameras in any mode in one screen.  
All the required settings should be done before connection is established. See chapter 3.1.3 for details.       
In order to establish connection, find a desired recorder on the site list, click left mouse button on its 
name, drag the name with button pressed over the display area and release the button when it reaches 
desired window. Depending on the settings in System/Display Option (see chapter 3.1) either live or 
search display mode is establish or the mode selection menu appears.  

Notice: Depending on interface layout settings site panel might be placed in any part of the window or 
 might be closed. In order to locate the panel or activate it when it’s closed View / Site 
Panel / Remote Sites Panel menu can be used.  

 Panel bar changes the colour then (default colour is blue). 

 

 Two different stages of connecting process are presented below.  
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After a while, connection is established and camera images are displayed successively, starting from 
site name drop target window. Similarly, after DVR channel list expanding (clicking on „+” mark  
placed next to DVR name) any camera name can be dragged and dropped on any window.  
Complex views of cameras from different DVRs and in different modes may be created that way. 
Search mode cameras are marked with S letter in the left lower part of its image.  
The pictures below shows successive stages of connecting to the 2nd channel in live view mode and 
then connecting to the 5th channel in search mode. Displaying a camera view more than once in one 
display screen is not possible. 
Cameras in playback mode are indicated by the  icon. Example below illustrates the steps of 
connecting camera 2 in “live” and camera 5 in playback modes: 

 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
In order to cancel connection with particular site any camera window from that site should be selected 
and the following icon       should be clicked. The other way of disconnecting is to enter the System 
menu and selecting Disconnect item. 
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In case of numerous sites defined the name search feature might be useful. In the upper part of site 
panel name or just the first part of the searched site name should be typed in. The search icon 
(magnifying glass icon)  should be clicked. The first site which fulfils search condition is shadowed 
with gray colour. When more than one site name fulfills search condition successive icon clicking 
selects next site name. Test site searching is presented below: 
 

 

 

 

As it was described for sites favourite sites connection is possible. The difference is that in favourite 
site connection search or live mode is already defined for each camera in layout settings. (see chapter 
3.1.4). Search feature is disabled for favourite sites. 

Live camera display mode Search displayed camera 

Camera name / 
description 

PTZ mode enabled 

System clock. Current 
DVR system time or 

playback time 

LIVE WATCH MODE 

Live mode camera 

Search mode 
camera 

Site name Camera name 
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Camera display window may display either only one camera or one of a few screen divisions. All 
other panels and menus may be hidden if necessary. In order to go back to regular window display 
ESC on PC keyboard should be pressed.  
Screen division may be changed using one of the icons presented below. If you click the last two icons 
successive channels set in particular screen division mode can be selected, e.g. next group of 4 
cameras in 2x2 mode. 

If presented icon bar is not displayed enter View / Toolbar and select Layout Toolbar.  

Once the left edge of this bar is “caught” it can be easily moved to any part of the main window. 

 
 
 
 
 
 
 
 
 
 
 
In case of the lack of video signal, the following info appears: 
 
 
 
 
 
When in live view mode camera title displayed in any channel window can be easily changed. It 
changes immediately after changing. Channel title changed that way is different only in RASplus 
software and is not saved in DVR settings. Default camera titles are the same as the titles set in DVR. 
Ain order to change camera title click on a desired channel window and click the right button to 
display the following menu. Once it is displayed select Change Camera Title, type in new title and 
confirm the change with the OK button.  
 
 
 
 
 
 
Camera title can contain up to 33 characters. Notice that long camera titles might be shortened in split 
screen. 

 

 

Show only camera display 
window 

Previous / Next channel set  
in current screen division 

Screen division 
from 1 to 8x8 
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4.2 Auto Sequencing 

RASPlus software can automatically connect to selected sites for a selected time. Before auto 
sequencing start appropriate setting must be done. It is described in chapter 3.1.5 how to set desired 
sites and connection time.  

„Live” connection offers the possibility of changing image window proportions as well as using 
ceratin image filters. This time the operation of said options is only temporary and applies to 
particular windows separately. 
After clicking RMB on the picture window, please select Aspect Ratio and one of the following 
options: 
 Fit to screen fits the displayed image to the window size regardless of its proportions.  
 Original Ratio forces the 4:3 picture ratio without deforming it. May force certain  parts of 
the display window to display black. 
 Half Size (x0.5) and Actual Size (x1) allow for changing proportions during  display of the 
picture window.  
 Antialiasing- enhances displaying of oblique edges.  
  
4.3 Sound transmission 

RASPlus allows for bidirectional sound transmission during „live„ connection. 

To play audio recordings form a single DVR audio channel please click RMB on the picture during  
connection and select Enable audio. After a short while, the following menu appears:  

 

 

Sound should be audible after pressing the speaker icon. Depending on the DVR menu settings it 
might be necessary to select the audio channel that sound is transmitted from. Every other situation 
will have the sound transmitted on a particular channel without the possibility of changing it. 

Breaking the transmission occurs after clicking the icon again, closing the menu (X icon) or selecting  
Disable audio from the pop-up menu. 

 

To transmit sound to the DVR speakers, please click the mic icon. Sound is transmitted until: next 
clicking of the mic icon, speaker icon, X icon or selecting Enable audio from the pop-up menu. 

Note: To secure a proper sound transmission please connect and configure the audio devices 
(speakers/microphones) both at the DVR and RASPlus ends. 
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4.4 Image parameters adjustment 

When in the live watch mode image parameters adjustment is available. This feature is suitable for 
example, to brighten dark channels. Both full and split screen images can be adjusted. In order to 
change image parameters desired channel window should be selected (green frame marked) and then 
appropriate panel should be opened. The following icon might be helpful to find it 

 

Notice: Depending on GUI settings, the panel can be placed in a different window part or might be 
 hidden or closed. In order to open or disclose the panel enter the View menu and select 
 Control Panel  / Color Control Panel.  

Once it is selected, panel bar changes colour to active (blue is the default setting for Windows OS) 

Panel icon function is described below: 

 
 
 
 
 
 
 
 
 
 
 
All the changes done using this feature are stored and are active even after software closes and 
restarts. Only default restore icon (see above) clicking or software reinstalling brings back all image 
settings to default. 

 

4.5 PTZ control 

If there are PTZ cameras available in a system (PTZ icon in upper right corner of camera image) user 
can control them using RASPlus software. PTZ control wiring and appropriate DVR settings are 
presented in DVR’s manual. 

PTZ control is available both in the full and split screen modes. 

Notice: In order to achieve smooth and non delayed reaction of PTZ camera proper transmission 
 bandwidth should be set in Network menu of  DVR. This value should be similar to the real 
 bandwidth of the network. 

 
In order to control the camera, its window should be selected (green frame marked) and then 
appropriate panel should be opened. The following icon might be helpful to find it 

 

Brightness adjustment 

Contrast adjustment 

Hue adjustment 

Default settings restore 

Colour saturation 
 adjustment 
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Notice: Depending on GUI settings the panel can be placed in a different window part or might    
 be hidden or closed. In order to open or disclose the panel enter the View menu and select 
 Control Panel  / PTZ Control Panel.  

Notice: PTZ control is available only during live watch mode. 

Once it is selected, the panel bar changes colour to active (blue is the default setting for Windows OS) 

 
Panel icon function is described below: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When “preset save” icon is clicked the following menu appears.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In order to save current camera position as a preset select any position on the list, name it and click 
OK icon. 
When you select preset, similar menu appears. Saved list entries should be selected and confirmed in 
order to recall preset. 

LIVE WATCH MODE 

Pan and tilt control  
cursors 

Zoom control 

Iris control 

Preset save 

Preset recall 

Focus control 

Open menu 
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 Another way is a very intuitive control via moving the cursor on the live camera picture. To start 
remote controlling, please press LMB in the centre of the live picture, and move the cursor in the 
desired direction while keeping LMB pressed. Pointer should change its shape to one of  presented 
below (depending on direction of the movement): 

 

 

 

 

The more distant the pointer form the picture center, the bigger angular speed of the camera. 

To stop camera movement, please release the LMB. 

Mouse scroll is responsible for zoom adjustment. Pointer changes its shape to one presented blow 
afterwards (depending on the change direction). 

 

 

4.6 Alarm output control 

Depending on the mode either 4, 8, 9 or 16 alarm outputs are available. All outputs can be remotely 
controlled from RASPlus software which can be used for, example, for remote control of any device.  
Alarm output control wiring and appropriate DVR settings are placed in DVR manual. 
In order to control the alarm output appropriate panel should be opened. The following icon might be 
helpful to find it: 

Notice: Depending on GUI settings the panel can be placed in a different window part or might    
 be hidden or closed. In order to open or disclose the panel enter the View menu and select 
 Control Panel  / Alarm Out Control Panel.  

Notice: Alarm output control is available only during live watch view mode. 

Once it is selected, the panel bar changes colour to active (blue is the default setting for Windows OS) 

Panel icon function is described below: 

 
 
 
 
 
 
 
 
 
 
Notice: Using remote output control feature user should remember that remotely switched on outputs 
 cannot be switched off locally using DVR front panel button. When output is switched on 
 remotely, it cannot react to some events, e.g. motion detection.  

Particular output 
switching on 

Particular output 
switching off 

Previous alarm output 
group selecting Alarm output number 

Next alarm output 
group selecting 

LIVE WATCH MODE 
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4.7 Live watch view using site maps  

RASplus software has a  map creating function which makes camera across system orientation easier.  
Using map feature only live view mode is available and no recordings can be played back.  
In that way of view connection is alternative to regular “drag & drop” connecting described in chapter 
4.1 of this manual. 
Map making process is described in chapter 9 of this manual. 
In order to use maps map panel should be opened. The following icon might be helpful to find it 

 
Notice: Depending on GUI settings, the panel can be placed in a different window part or might   
 be hidden or closed. In order to open or disclose the panel enter the View menu and select the  
 Map Panel.  

Once it is selected, the panel bar changes colour to the active (blue is default setting for Windows OS) 

After panel opening there aren’t any map loaded. In order to load a map click the right mouse button 
above the panel area, select Open icon, select path to RMP format map and click OK. After a while a 
map is displayed and connection to defined map elements is established.  
In case of multi level maps a top level map should be opened first and then using links on it sub-level 
maps can be opened.  
In order to close the map click right mouse button above the panel area, select the Close icon.  
 
 
 
 
 
 
 

LIVE WATCH MODE 
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4.7.1 Map components  

Typical map components are explained below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
User is able to quickly find out each component state. 
One way of state visualization are icons appearing close to the component.  
The meaning of those state icons are as follows: 
 
 component is not defined in map settings or there is no connection to DVR 
 component is disabled 
 auto-diagnosis system found this component operation as abnormal 
 video loss occurred 
 motion detection is activated  
 alarm input is activated 
 alarm output is activated 

Active component - 
other map link  

Passive component - 
map background  

Active component - 
camera type  

Active component - 
alarm output type  

Active component - 
alarm input type  

LIVE WATCH MODE 



Instrukcja obs
ugi oprogramowania sieciowego Multi-Viewer 2.54 . Wersja 1.0. 
 

RASplus - User’s manual ver. 2.3. 

All rights reserved © AAT Holding  Sp. z o.o.   
 

52 
 

The other way of state visualization is component colour changing.  
Depending on settings done during map creation, component icons can be displayed in different 
colours, depending on events, red for example. 
 
 

Colour visualisation settings are described in chapter 9 where map crating process is explained 
 
 
Additionally, after you move a cursor over component icon detailed information about component can 
be displayed.  
 
 
 
 
 
 
 
 
Name: - name assigned to the element 

DVR Name: - IP address or assigned to address DVR name, which component is physically 
connected to. 
Device Num: - component number  
State:  - component status 

 Component state can be described as follows: 

 Unplug - component settings are not defined in map setup menu or there is no connection  
 with DVR 
 Normal - no motion, no video loss, no external alarm detected 
 Disable / system check not used - component state is not checked by auto-diagnosis 
 system 
 Motion Disable - motion detection is disabled for this channel (component) 
 Motion Detect - motion detection feature is enabled, motion is detected  
 Warning - alarm output is active 
 Detect - alarm input is active 
 Video Loss  - video loss detected 
 Unstable - component operation is detected as unstable for a given period of time  
 
Description: - any description for better component identification or including other information  
 important for a user   

LIVE WATCH MODE 



Instrukcja obs
ugi oprogramowania sieciowego Multi-Viewer 2.54 . Wersja 1.0. 
 

RASplus - User’s manual ver. 2.3. 

All rights reserved © AAT Holding  Sp. z o.o.   
 

53 
 

4.7.2 Camera image displaying  

As it has been mentioned before, the main advantage of map using is intuitive camera system  which 
helps to manage camera images more effectively. Operators don’t have to remember where the 
camera is installed. Its physical placement according to site background is represented  by icon.   The 
best way of using map feature is to install dual output VGA card in PC. Thanks to this user can 
arrange panels layout conveniently. Map panel can be displayed on one monitor, camera view window 
on the other without interrupting and covering map. 

Camera selecting can be done in two ways:  

a) Images from cameras are displayed as separate windows starting from the upper left corner of 
the screen and cover other panels. Together with the image in the upper part of the window 
DVR IP or name and camera name are displayed.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

 Camera image can be displayed after you click on a component icon or automatically after 
 event is detected. Display settings initiation are set during map creating. In the upper right 
 corner of each camera window round icon for window closing is displayed. The left button 
 clicking and holding it pressed allows to move the window.  

LIVE WATCH MODE 
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 Windows size can be adjusted. When at least one camera window is displayed click right 
 mouse button on it to display the following context menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 The first 8 positions on the list are used for temporary window size changing (after you close 
 it and open it again it will be displayed in a standard size) . 
  x 0.25 makes the window 16 times smaller than default one 
  x 2 makes the window 4 times bigger than default   

  x 1 makes the window size default  
  Full Screen - expands the image to the whole screen area 
 In the User Set.. menu default size of the window can be defined by selecting a position from 
 the menu  and confirming by clicking OK button. 
 
 
 

  
 When 2x2 is set default window size is defined around  512x350 pixels. 
 When 8x8 is set default window size is defined around  120x90 pixels. 
 Other settings give intermediate widow size. 

 Using the Transparency… menu from the same context menu user can adjust windows 
 transparency. Transparency might be useful for “background” application observation 
 for example to watch map icons “covered” by camera image window.  
 
 
 

 Transparency can be set using the slider showed above. Adjustment is accepted by clicking 
 the Apply button  . 

 The very right slider position refers to complete transparency, the very left position means 
 zero transparency level.   

 Transparency setting is temporary and is effective until window closing. Default setting          
 is zero transparency.  

 Transparency factor can be set independently for each window.  

LIVE WATCH MODE 
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 Alarm outputs can be also controlled remotely form site map level. In order to let user control 
 alarm outputs during map creation proper function for a given element must be switched on. 
 Output switching on and off is done by the left mouse button clicking the alarm output icon 
 clicking. 
 If local PTZ control is possible from the DVR remote control from the map panel is also 
 possible. The following features are available: pan and tilt control, zoom and focus control, 
 preset save and recall, iris control. In order to start PTZ control appropriate menu should be 
 displayed by clicking the right mouse button on camera image window and choosing PTZ 
 Set... The following window appears. Icon functions are as follows. 

 
 
 
 
 
 
 
 
 
 
 
 
 
b) Another way of camera image display is “dragging & dropping” an icon  on the main image 

display window of RASPlus software as it is with site name “dragging & dropping”  described 
in chapter 4.9. 

 Using that way of image display all settings described in point a) of this chapter are not  v a l i d . 
 Display modes and external devices control are done in a way described for standard site 
 cameras display. In order to close connection with a site click a camera window and select the  
 following icon         should be clicked or go to the System menu and select Disconnect . 
 
 
4.7.3 Monitoring events via map panel. 

Clicking RMB on the map and selecting  Watch Event View allows for monitoring events that 
occured in locations connected with the software via launching a particular map. The functions is an 
analogue of the one described in chapter 4.9. 

Pan and tilt control cursors 

Iris control 

Zoom control 

Preset save, 
Preset recall 

Focus control 

LIVE WATCH MODE 
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4.8 Emergency event view 

Novus 5000 series DVRs have emergency callback feature utilizing IP or phone number of client’s 
software for notification. Thanks to this feature RASplus operator is automatically informed about 
emergency event. Those events are listed in the Emergency Event View panel even if there  is no 
connection with the source DVR.  
The only condition for callback messages receiving is proper DVR setting (see DVR manual for 
details) and RASplus software running. 
Events on the list appear chronologically, depending on time of event occurrence. The latest events 
are listed on top.  
Every new event is announced with sound (if only PC has speakers connected) even if the panel is 
currently  closed.  
In order to receive emergency callback messages the Emergency Event View panel should be 
opened.  The following icon might be helpful to find it 

 
 
Notice: Depending on GUI settings the panel can be placed in a different window part or might    
 be hidden or closed. In order to open or disclose the panel enter the View menu and select 
 Emergency  Event View Panel.  

Once it is selected panel bar changes colour to active (blue is the default setting for Windows OS) 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Emergency event notification message contains 3 component information: 
- the first column named Site contains site name where given event comes from 
- the second column (Event) contains icon representing event type and in some cases input related 
 name; icon meaning is the same as it was described in a previous chapter for DVR event log 
- the last column (Date/Time) shows date and time of event occurrence  
 
Emergency Event View panel contains events that have occurred since application start-up till now.  
After software start-up event list is empty. In order to display all emergency events stored since 

LIVE WATCH MODE 
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There is a simple way to review the recording associated with emergency event message. In order to 
do that click left mouse button on event entry on the list ad “drag” it with the button pressed over 
image view window. Depending on the software settings live watch, search mode is activated or 
connection mode menu is displayed. Further operation is typical for given mode.  
 
4.9 Watch event view 

Other callback notification mode is Watch Event View. 
Using this mode all clients connected to a particular site in live watch mode are informed about events 
happening at that site.  This callback information is the same as the one described before but in this 
mode they brings only information not a warnings because they are not dedicated to any specific client 
station but to all connected users. 
The only condition for callback messages receiving in this mode is RASplus software running and 
live watch view connection with the event source site. Events on the list appear chronologically, 
depending on time of event occurrence. The latest events are listed on the top. 
In Watch Event View a new event isn’t indicated with sound. 
To open the list, please activate Watch Event View. An icon might be helpful to find it: 
 
 
Notice: Depending on GUI settings, the panel can be placed in a different window part or might   
 be hidden or closed. In order to open or close the panel enter the View menu and select 
 Watch Event View Panel.  

Once it is selected, the panel bar changes colour to active (blue is the default setting for Windows OS) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Similarly as it was described in the previous chapter event notification message contains 3 component 
information. The Watch Event View panel contains events that have occurred since application start-
up till now.  Unlike the Emergency Log event list is not stored and after software is closed it is lost 
for good. 
Unlike the Emergency Log there is no “drag & drop” method for event related images review.  

LIVE WATCH MODE 
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5. REMOTE DVR MANAGEMENT  

5.1 DVR status view 

User is able to check DVR status remotely using RASplus software panel called Camera Status 
Panel. The following icon might be useful for panel finding.  

 

Notice: Depending on GUI settings the panel may be placed in a different window part or be hidden/
closed. In order to open or disclose the panel enter the View menu and select Camera Status Panel.  

Once it is selected, the panel bar changes colour to active (blue is the default setting for Windows OS) 

One DVR status can be checked at a time. The status of both connected and disconnected DVRs can 
be checked by means of this feature.  

In order to start status check feature desired site name should be selected on site list and the right 
mouse button should be clicked on it. Using context menu select Connect Status View. After a 
while connection is established and current remote DVR status data is downloaded.  

 

Exemplary panel  view in horizontal orientation is presented below: 

 
The upper left corner of the panel control is occupied by icons. Their function is described below. 

Close status view mode 
connection 

Enabling/disabling panic 
recording feature. 

Go to DVR menu,  
see chapter 5.2    

Go to System Log of remote 
DVR, see chapter 5.3.1  

REMOTE DVR MANAGEMENT 

Go to System Log of remote 
DVR, see chapter 5.3.2  
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System elements status icons are gathered in the central part of the panel. The first row which digits 
corresponding to the  video channel, alarm input and output can be found below.  
The cons below assigned to each input number can represent one of three states: 

disabled (dark grey) - means that particular feature is disabled for given input/output 

inactive (light grey) - means that particular feature is enabled for a given input/output but event does 
not occur 

active (colour) - means that particular function is enabled for a given input/output and additionally  
  event occurs  

The meaning of each icon and its state is described below: 

motion detection is disabled  for a given video channel 

motion detection is enabled for a given video channel, motion is not detected 

motion detection is enabled for a given video channel and motion is currently detected 

external alarm feature is disabled for a given input 

external alarm feature is enabled for a given input, no external alarm is detected 

external alarm feature is enabled and alarm is currently detected 

given alarm output is not active 

given alarm output is currently active 

given camera input is disabled 

given camera input is enabled, video loss is detected 

given camera input is enabled and operates properly 

auto-diagnosis feature is disabled for a given alarm input 

auto-diagnosis feature is enabled  for a given alarm input, input works improperly 

auto-diagnosis feature is enabled for a given alarm input, input works properly 

auto-diagnosis feature detected proper recording opearation 

auto-diagnosis feature detected improper recording status 

REMOTE DVR MANAGEMENT 
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Right part of the panel contains the following information: 

¬ DVR functions: recording, playback, archiving, manual backup;  
 grey colour of the icon means that function is not proceeded at the 

 moment, other colour means that function is being proceeded right 
 now 

5.2 Remote DVR setup 

RASplus software allows for remote DVR setup after connection is established. In order to setup the 
DVR user should be logged in as an administrator (details in DVR manual) 
In order to enter remote setup menu click  the right mouse button on desired site name and select 
Remote Setup from the context menu or enter Remote / Remote Setup in the main window. 

After a while setup window similar to local DVR GUI is being displayed. 

 

. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

¬ site name information whose status is currently displayed 
¬ oldest available recordings 
¬ latest available recordings 
¬ icons informing about currently active functions  
¬ DVR software version 

REMOTE DVR MANAGEMENT 
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Menu navigation is done by means of mouse cursor. In order to accept changes done in each submenu 
the Save button should be clicked (notice that submenu button should be clicked and not the Save... 
button in the lower left part of the window which is used for setting file on PC saving).   All changes 
are done in off-line mode (only in PC memory). In order to load changes to the DVR OK button of the 
setup menu should be clicked. If you click Cancel that none of the changes are sent to the DVR. 
Current DVR settings can be downloaded and saved on PC HDD for further use. In order to do that 
click Save... and define target path. In order to load previously saved settings the Load... button 
should be clicked and settings file should be selected. Because of security reasons DVR settings menu 
does not contain System Shutdown, Logout and Storage positions. 
The meaning of the menu items is described in DVR manual.  
Motion detection grid (or object detection in NV-DVR5816) is the only setting that is not configured 
other than locally. After you enter motion detection grid setting menu picture from particular camera 
is displayed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the background you can select desired active areas from 256 cells.  
Grid edition can be done in the two modes: cell activating and deactivating.    
In order to enable cell activating mode the following icon should be “on” 
 
In order to enable cell deactivating mode the following icon should be “on”  
 
During activating and deactivating modes 3 editing tools are available: 
 
   that tool allows to edit single cell after on-cell clicking 
   that tool allows to edit rectangular areas by means of click & drag method 

   that tool allows to edit the whole image area in one click  

 
If you click OK the changes are saved. If you click Cancel you exit the menu without saving. 

REMOTE DVR MANAGEMENT 
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NDR-HA-6000, NDR-HA5000, NDR-HA4000, NDR-HA2000, NDR-HA1000 recorders feature 
adjustable network bandwidth utilised for transmission.  
Network submenu in the DVR’s menu is responsible for said adjustments. Menu is accessible both  
remotely (RASplus) and locally, giving the possibility of adjusting data transfer parameters to current 
network capability utilising 2 or 3 parameters. 
Depending on the network admin’s requirements as well as network capability adjusting the 
maximum transfer speed is possible via the Transfer Speed (bps/ips) described in either Kbps/
Mbps  or images per second (IPS). 
Additionally, in order to be capable of adjusting the image refreshing rate for a given transfer speed , 
please select one of the available quality levels (Quality) Lowest quality being the fastest refreshing 
rate (Basic). 
Highest quality - slowest rate for (Very High). 
 
Further details are described in separate DVR manuals. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

REMOTE DVR MANAGEMENT 
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5.3 Recorder log view 

Using RASplus software user can remotely search DVR system and event log. Unlike it was 
described in chapter 3.3 log is related to the DVR not to client software.  

5.3.1 System log view 

In order to display system log select desired DVR on site list, click the right mouse button and select 
Remote System Log from the context menu. The log window is displayed after a while.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
In order to display log entries click the  Find button.  
In order to display events starting from the  oldest stored in DVR memory tick the From First option. 
In order to display events stored up to the  present moment tick the To Last option. 
In order to choose specific time period un-check From First and/or To Last and select date and time 
in the From and To fields. 
Up to 100 events are displayed at once starting from the latest. In order do watch them all a slider 
located in the right part of the window should be used. In case more than 100 events are stored in 
search period next 100 can be displayed after the following icon is clicked       . The following icon 
should be clicked in order to display the previous 100       . 
The first column in the log list first column shows event number, the second column shows event type 
together with information whether it is caused by local or remote operator. In the last column date and 
time of event occurrence is displayed. 

REMOTE DVR MANAGEMENT 
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All displayed entries can be saved as CSV files. Save… button should be clicked, file name and 
destination specified in order to do that. 
Displayed entries can be printed out by means of a system printer. In order to do that, click the  
Print… button and set printing parameters. Only 100 displayed events can be printed at one time. In 
order to print following events display the next group first.  
Printout example is presented below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

REMOTE DVR MANAGEMENT 
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5.3.2 Event log view 

In order to display event log, select the desired DVR from the  site list, right button click and select 
Remote Event Log from the  context menu or click next tab while system log is displayed.  
 
Log window is displayed after a while.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Window appearance, search mechanism, saving and printing functions operate the same way as it was 
presented for the system log in the previous chapter.   
In the event log, events are represented by means of icons. Their meaning is as follows: 

 
 
 
 
 
 
 
 
 
 
 
 
 

motion detected 

video loss detected 

external alarm detected 

transaction detected 

improper alarm input operation reported by the  auto-diagnostic system  

improper recording operation reported by the auto-diagnostic system  

improper HDD operation reported by the S.M.A.R.T. system 

bad sectors reported by the auto-diagnostic system  

HDD full reported by the auto-diagnostic system  

HDD overheating reported by the auto-diagnostic system  

REMOTE DVR MANAGEMENT 
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5.4 Site status report feature 

RASplus has a specialized module for periodic site status checking and reporting. Appropriate 
settings in System2 tab accordingly to chapter 3.1.2 should be done first in order to run the report 
feature. At regular, specified intervals the software checks all site status and adds a result to the list. In 
order to view that list, the Report View Panel should be opened.  

Notice: Depending on GUI settings the panel can be placed in a different window part or may be 
 hidden or closed. In order to open or disclose the panel enter the View menu and select 
 Report View Panel.  

Once it is selected, the panel bar changes colour to the active (blue is default setting for Windows OS) 

Exemplary panel view is presented below: 

 

 

 

 

 

 

 

 

The first column contains symbols indicating information about connection result. In the example 
above, connection is established for demo site only. The second column displays status checking date 
and time. In the third column, site name is located, the fourth column shows active video channels, the 
fifth one shows alarm inputs states. In the sixth column, recording status is shown. The seventh 
column is for recording auto-diagnostic results. The last one shows the time range of available 
recordings. 

The report list contains all status check results since the time range last RASplus start-up. Number of 
entries depends on the number of defined sites, status checking interval and software running time. 

Notice: All entries are available until next software closing. In order to save it before software closing, 
 Print the report should be used by clicking on       . PDF file can be save that way if only 
 PDF printer is available in a system. There is no other way to save the report. 

The icon allows for running the location check at any moment, i.e. without waiting for a scheduled 
check. 

REMOTE DVR MANAGEMENT 
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6. SEARCH MODE 

The RASplus software allows to search and play recordings from defined DVRs remotely. Normal 
recording and archive data can be played back using one of following searching methods: date/time 
searching, event searching. 

6.1 Recording source selecting 

Before establishing connection in the search mode, recording source can be selected from among 
normal recording storage or archive storage. Default is first option, so if there is no archive HDD in 
the target DVR, the currently described setting can be omitted.  

In order to change data source, Search View panel should be opened first. The following icon might 
be helpful to find it 

 
Notice: Depending on the current GUI settings the panel can be placed in a different window part or 
 may be hidden or closed. In order to open or disclose the panel enter the View menu and 
 select Search Panel.  

Once it is selected, the panel bar changes colour to the active (blue is default setting for Windows OS) 

Following icon       from the Search Panel should be clicked in order to display following data 
source selecting menu 

 

 

 

 

 

- Search on Local - standard storage for basic recording process 
- Search on Archive - archive storage (as internal and external) 
After recording source selection,  OK clicking is necessary to confirm or Cancel clicking for leaving 
the menu without saving changes . 
 
6.2 Searching recordings by date / time 

In order to start playback connection in the search mode should be established before. Connection 
procedure is similar to the live watch mode connecting and “drag & drop” method is also used.  
Depending on the situation, single-camera connection (camera name “dragged & dropped”) or all-
channels-at-one-time connection (DVR name “dragged & dropped”) can be established.  
If the selected DVR is properly defined and available in the network, recording timetable  and date are 
loaded automatically, and the Search View panel becomes active.  

Notice: Depending on the current GUI settings the panel can be placed in a different window part or 
 may be hidden or closed. In order to open or disclose the panel enter the View menu and 
 select Search Panel.  

Once it is selected, the panel bar changes colour to the active (blue is default setting for Windows OS) 

SEARCH MODE 
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When only single camera is selected for playback it is displayed where its name was “dropped”. When 
DVR name was “dropped” all cameras from this DVR are displayed successively beginning from the 
window where the DVR name was “dropped”.  

Live watch and playback simultaneous display using different windows of the screen is possible. 

Search View panel in default mode (date/time searching) is presented below with the explanation of 
its contents. 

 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
Playback starting point selection begins with day on the calendar (or even month or year if necessary)   
Calendar window represents one month. Month or year selection is done by means of arrow icons.  
Days are grouped in a column order. Starting from the left: S (red colour) means Sunday,                  
M - Monday, T - Tuesday, W - Wednesday ,T - Thursday, F - Friday, S - Saturday. 
Numbers on the calendar which are bolded represent days from which recordings are available. 
Numbers on the calendar which are displayed with grey font represent days from which recordings are 
not available. The currently selected day is distinguished with light-blue font.  
In order to select a day, just click its number on the calendar.  
 
 
 
 
 
 

Selected year, 
year selecting 

arrows 

Selected month, 
month selecting 

arrows 

Days of the week 

Days of the month 

Recordings are 
available from this 

day 

Selected day 

No recordings 
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After date selection, there is a colourful round-shape graph displayed in the right part of the panel. It 
represents 24 hours of a day.  
 
 
 

 
 
 
 
 

 
 

 
 

 
 
 
 
 
Clicking LMB on the recording bars loads the records originating from a selected period, with the 
playback start marked by a vertical red line. 
 
Clicking and holding the LMB on the time bar allows for „moving” it skipping either to earlier (to the 
left) or later (to the right) recordings.  
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Clicking the „change tab display mode” icon  either brings up general overview of every channel or a 
detailed view, as depicted below. In order to check all channels, scrolling may become necessary.  
 
 
 
 
 
 

Clicking the „change the time bar resolution” icon also switches between general and detailed time 
display modes. The difference in resolution is about twofold.  
 
 
 
 
 
 

Further Podgl� d Search description is  identical for all DVR models. 
In order to select playback start time please click the  icon. 
 

 

 

 

 

Next, please enter the desired hour, minute and second (either by highlighting and entering numbers via 
numerical keyboard or marking and using arrow icons) and press OK. 
 
After selecting a start point, system will find a recording originating from that given time period and 
display it in pause mode or show an information when no recordings are available for that given time 
period. 
Loading pictures may take longer in systems with low network bandwidth. 
To start playback please use playback control buttons. Their functions are described below: 
 
 
  

SEARCH MODE 

Change playback speed, active only 
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REW/FF speed change, available only 
during fast forward/rewind. 
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One frame back One frame 
forward 
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playback 
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Played back recordings can be displayed in full screen and split screen mode. Changing the isplay can 
be done the same way as described for live watch mode in chapter 4. 
If there is more than one recording segment within the selected time period it is possible to switch 

between them using following icon  

Such a time overlap case appears with automatic winter/summer time changes, or when system clock 
has been changed manually. 

In order to stop playback and close the search mode, any window containing images from a camera 

should be selected and the icon          ought to be clicked afterwards. Alternatively Disconnect option 

should be selected from the System menu.  

The search mode connection is also terminated automatically after few minutes of user inactivity.  

 
6.3 Searching for event recordings 

In order to start playback, connection in search mode should be established before. Connection 
procedure is the same as described in the previous chapter and for the live watch mode in chapter 4. 
After establishing connection, the default search mode is by date/time. The icon        must be clicked 
to switch to event search mode. 
After a while, the following menu is displayed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
First section allows the user to define the time range for searching.  
In order to display events starting from oldest stored in DVR memory, tick the From First option. 
 

SEARCH MODE 
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In order to display events stored up to the present moment, tick the To Last option. 
In order to choose a specific time period, deselect the From First and/or To Last option and select 
date and time in the From and To fields. 
The next part of the menu is designed to define an event type to be searched for defining.  
Following events are available for searching: 
Alarm-In (external alarm) 
Motion (motion detection) 
Video Loss (video signal loss) 
Text-In (text data) 
Camera (all channel related events) 

Any number of events can be selected. 
Channel number (or alarm input number) from 1 to 16 (8) (9) (4)) can be selected for searching 
events related with them.  
Using the All option, all 16 (8) (9) (4) channels can be selected/deselected at one time. 

Recorder Bad (the auto-diagnostic system detected no recordings within the selected time period)  

Alarm-In Bad (the auto-diagnostic system detected no external alarm within the selected time period) 

Disk Temperature (HDD temperature elevated)  
Disk Bad (the auto-diagnostic system detected bad sectors on the HDD) 
S.M.A.R.T. (HDD errors detected by the said system) 
Panic Record (panic recording started) 

Disk Almost Full (assigned disk storage space almost exceeded) 
After selecting search conditions,  click Find in order to start the database searching process. 

After a while, depending on the time range selected, the search result will be displayed as an event 
list: 
 
 
 
 
 
 
 
 
 
 
 
 
Each single entry contains information about the site (DVR) where it came from, event type and date/
time of event occurrence.  
By selecting each particular entry from the list, playback of related recordings can be started. 
Playback control and screen division/camera selection is identical to the procedures described in the 
previous chapter (date/time playback). 

SEARCH MODE 
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When no recordings that meet the search criteria are found, the following info is displayed: 
 
 
 
 
 
In case that more than 100 events match the search criteria, the following info window is displayed. 
 
 
 
 
 
The first 100 entries are displayed on the list. In order to display the next group, the following icon 
should be clicked  
In order to change the search criteria, the following icon should be clicked  
In order to switch the search mode to date/time, the following icon should be clicked 

In order to stop playback and close the search mode connection, any image window featuring camera 

images should be selected and the following icon       clicked  or the Disconnect option should be 

selected from the System menu.  

The search mode connection is also terminated automatically after a few minutes of user inactivity.  
 
6.4. Motion search 
 
RASplus software features the picture analysis function allowing for detecting movement or object 
disappearance in a selected part of camera’s field of view.  
In order to activate the function please connect to the DVR in Search Screen mode. Connection is 
started as described in the previous sub-chapter.  
By default, Search View is displayed in the date/time search mode after a successful connection-as 

described earlier. To open Motion Search window please click the icon.                    

SEARCH MODE 
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Record Period field allows for selecting the recordings time period for subsequent analysis 
by RASPlus software. Date is set using calendar, which becomes available after clicking the                         
 icon. 
 
 
 
 
 
 
 
 
 
 
 
Next, Find method box allows for selecting the mode of picture analysis from one of two 
available - Motion detection and Object disappearance.  
 
  

SEARCH MODE 



Instrukcja obs
ugi oprogramowania sieciowego Multi-Viewer 2.54 . Wersja 1.0. 
 

RASplus - User’s manual ver. 2.3. 

All rights reserved © AAT Holding  Sp. z o.o.   
 

75 
 

Each of the two methods has its own adjustable parameters:  
For Motion Search; Sensitivity ranging 1 to 5 and Num of diff. block ranging 1 to 20. 
 
 
 
 
 
For Object disappearance; Sensitivity ranging 1 to 5, Diff. % to ref. image ranging 50 to 
100 and Activation Time (Sec) ranging 5 to  100 seconds. 
 
 
 
 
 
 
 
In order to mark the area for analysis, please click the icon and place the area on the 
picture from a camera, the area being highlighted in orange. 
 
To remove a selected area, please  click the icon and highlight an area to be removed. 
 
To start motion search, please click the Search button, software will start playback 
according to a timeframe set earlier, simultaneously analyzing it. Event list is displayed in 
the bottom right corner of the dialog window. If the number of events exceeds 100 please 
click the Next button. 
To stop motion search, please click Stop button. 
Double-click on the position from an event list starts its playback in the main RASplus 
window. 
Reset restores defaults for the whole motion search panel, i.e. date, search method, 
sensitivity, areas and event list. 
 
Object disappearance search is performed identically as Motion search. 
 

SEARCH MODE 
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6.5 Image processing 

The Search View option has some image processing tools implemented. Image processing may 
enhance image quality for better detail recognition. All transformations can only be done in the pause 
mode of the date/time and event search mode. Both full screen display and one of division screens can 
be subjected to transformation. The only condition is to select its first. The selected image is marked 
with a green frame around it. 
In the right upper part of Search View panel there are two bars located. Theirs function is as follows: 
  
- digital zoom bar for smooth close-ups  
- brightness bar for smooth brightness changing 
 
Starting playback automatically restores the  default image size and brightness.  

Other image transformation functions are gathered in a special panel called the Image Processing 
Panel. In order to open this panel use the following icon  

 
Notice: Depending on the GUI settings, the mentioned panel can be placed in a different part of the 
 screen or may be hidden or closed. In order to open or disclose the panel, enter the View / 
 Control Panel menu and select the Image Processing Panel. Once it is selected, the panel 
 bar changes its colour to the colour of the active window (default setting for Windows OS it’s 
 blue) 

The description of all icons that operate the filters in the Image Processing panel is presented below: 
 
 
 
 
 
 

 

 

Starting playback automatically restores the default settings and eliminates all changes done. 
 
6.6 Sound playback 

RASplus software allows for remote audio playback associated with video recordings.  
To playback audio during video playback, please click RMB on a picture from a desired camera and 
select Enable Audio. Sound from audio channel associated with a given video channel in the DVR 
settings should be audible in the PC speakers. 

Cancelling the sound transmission occurs after selecting Enable audio from the camera’s popup 
menu. 

 
 

Sharpening 
filter 

Equalizing 
filter 

Blurring filter 

Interpolation filter, for digital zoom 
artefacts reducing 

Filters performance withdraw; 
original picture restore 
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7. LOCAL VIDEO RECORDING, RECORDINGS BACKUP, PRINTI NG 

RASplus software allows the user to save local recordings. Also saving of video and still images on 
PC HDD, and printing of images is possible.  

7.1 Local video stream recording (panic recording) 

RASplus software gives the opportunity to watch video streams and save them onto PC HDD. With 
one icon click, live images from first 16 channels can be stored. This feature is called panic recording 
because using its help the user is able to save interesting recordings that have been observed even if 
the DVR doesn’t record images at a given moment. 

Before using the panic recording feature proper setting has to be done, as was described in chapter 3.1.  

In order to start recording in the live view mode click the following icon         placed on the main 
toolbar. From that moment video from the first 16 channels is stored. While panic recording is active, 
its icon changes its outlook to the following        Recording is continued until next icon click or until 
all allocated space used up (and the overwrite option is not selected). 

In order to play recordings saved before using the panic recording function RecordPlayer  has to be 
run using the following icon 

Description of player features can be found in chapter  7.6 of this manual. 

Notice: In order to play backup files created locally from the DVR or remotely using RASplus 
 software (see next chapter), player shouldn’t be started from the toolbar as was described 
 above, but from the Start menu of Windows OS. The RecordPlayer shortcut is located in the 
 Programs/ RASplus menu. 
 
Red R letter superimposed onto the camera picture in the upper left part of the window informs that 
the recording is taking place on that particular channel. 

 

If recording settings (described in chapter 3.1) allow for manual assignment of the cameras, user can 
select any 16 windows, that the pictures will be recorded from. Clicking RMB on a desired window 
and selecting Set Record Camera enables the function. When the 16-window limit is exhausted, 
system displays an appropriate message. Un-checking the option of recording a particular window 
frees system resources, therefore allowing next window to be selected for recording. Windows with 
recording assigned to them are indicated by gray R letter. Only these channels are recorded locally 
after clicking the       icon.  
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7.2 Capturing of a still image 

RASplus software allows for still picture capturing and saving as JPEG or BMP file. This function is 
operated by the following icon         . and it is also available in live watch and search mode. 

Captured is the image currently visible so it can be full screen camera image and split screen mode as 
well.  

In the live watch mode this function is triggered directly by clicking on the icon. In the search mode, 
after clicking on the icon additional menu is displayed and Save As Image… should be selected. 

Once the capture feature is started, there is special saving dialog box displayed where the user must 
input the target path, file name and if needed, select Include Image Info (software name and image 
creation time added as an info bar on the top of the image. 

LOCAL RECORDING, BACKUP, PRINTING 
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7.3 Printing images 

RASplus software allows the user to print camera images directly using a system printer. This feature 
is available for live watch and search modes. The currently displayed image is printed. Apart from 
images, extra information is also printed. This includes site name, date and time of printing etc. 

Exemplary printout is presented below.  
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7.4 Recordings to AVI backup 

RASplus software allows for remote backup of recordings to a PC as AVI file. This feature is 
available only during search mode connection  (Search View). The advantage of this backup method 
is a standard file format that allows for further playback using standard video players such as 
Windows Media Player. 
In order to backup recordings to the AVI file, click the icon         and from the displayed menu select 
Save As Video....After a while, backup menu will appear where recording period to be backed-up 
can be defined.  

Notice: It is recommended not to exceed 2GB filesize.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the first two rows, backup time range can be selected.  
In order to backup recordings starting from the oldest ones available, tick the From First option. 
In order to backup recordings until the latest available, tick the To Last option. 
In order to choose a specific time period, deselect the From First and/or To Last options, and select 
date and time in From and To fields. 
 
It is possible also to define which channels should be backed up (numbers from 1 to 16 (9) (8) (4)). 
Ticking All field selects/deselects all 16 (9) (8) (4) boxes at one time. Channels without recordings are 
not included on the list (e.g. channel 4). 
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Notice: When more than one channel is being backed up simultaneously, the best variant of the of 
split screen is automatically chosen. For example, when 2,3 or 4 channels are selected, those are 
backed up in 2x2 screen division, while 16 channels are backed up in 4x4 screen division and so on. 
That is why viewing one camera in full screen will not be possible during playback such an AVI file.  
This means that the quality of the backup video is getting worse when more channels are being backed 
up because the size of a single screen is getting smaller than the original size. 
 
 
 
 
 
 
 
 
 
 
AVI file contains also camera title and date and time of recording.  
 
If an audio channel was associated with a given video channel, adding an audio track during backup is 
possible. In order to do so, please check the Include Audio Data option.  
When simultaneously copying multiple channels adding only a single audio channel is possible. 
Next section of backup window contains AVI codec parameters. Please remember, that creating 
an .AVI backup may cause quality loss (recordings are compressed for a second time).  
Codec position allows for .AVI codec selection.  
Size defines the resolution of the output file.  
Anti-aliasing prevents the effect of „shredding” oblique edges, especially when switching the backup 
file to a lower resolution.  
Keyframe allows for setting the frequency of base frame creation in the AVI file. The more frequent 
base frame is, the better picture quality and file size.  
Quality allows for setting the compression level (quality) for a backup AVI. The bigger value, the 
better quality and file size.  

Next section of the copy window allows for setting the maximum AVI file size.  
As mentioned earlier, AVI file size may cause trouble with playback on certain operating systems. By 
default (when Limit File Size is selected) RASplus creates files not exceeding 2000MB=2GB size. 
When selected time interval requires more than 2GB of space, software divides the output file into 
parts with their sizes not exceeding said value (when Save Split File is selected) or finishes at 
reaching 2GB (when Save Split File is not selected). Splitting the backup file into parts with 
unrestricted sizes is also possible. In order to do so, please select Limit File Size and select the 
desired MB value. 

LOCAL RECORDING, BACKUP, PRINTING 
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Selecting View Proceeding Frames displays the overview of the processed frames constituting the 
AVI file. When operating on low-end PCs, selecting this option is not recommended. 
Clicking Start displays another menu, requiring pointing the destination folder for the backup file as 
well as naming the file. Clicking Save downloads the data onto the HDD and creates an AVI file. 
Duration depends on the amount of data, transfer speed, and PC computational power. Progress is 
visualised by a bar informing on file size and time. 
  
7.5 Recording to EXE files backup (MiniBank format) 

RASplus software allows for remote backup of recordings to the file format with EXE extension. 
This feature is available only during search mode connection  (Search View). The advantage of this 
format method comparing to AVI is that more than one channel can be backed up with further channel 
selection with playback feature. The second advantage is that the MiniBank format contains a “built-
in” player so there is no problem with player or codec incompatibility on any PC. The third advantage 
is the possibility to attach text data to backup recordings. The last advantage of the MiniBank format 
is watermark checking feature.  
In order to copy the data to MiniBank format, please click the       icon in Search panel, then select 
Save as Self-Player from a pop-up menu. 

Setting time and cameras for the backup recording is similar to settings performed during AVI file 
export. 
Selection of the recordings is performed either by entering backup menu-entering date and time 
manually or by another method, explained further below: 
Marking a desired part of the recording is also possible by creating timestamps. In order to do so, 
please click the        icon located in the Search panel. Current date and time are stored afterwards. 
After reaching an end of the desired part of the recording please click the icon again.  
Reached date and time are stored again, this time indicating the end of the backup recording. Backup 
menu is then displayed as described in previous chapter, with From:  To: fields. 
When copying recordings from more than one camera to the MiniBank format, quality degradation 
does not occur. Additionally, selecting particular channels and displaying them full-screen is also 
possible. 
Backup copy may be password-protected. In order to protect it, please select Save Password prior to 
starting backup.  
If recordings from a given period are associated with text, it is also possible to copy the text for later 
playback. Please select Include Text-In Data in order to do so.  
Selecting Dont’ ask about file limit allows for creating single files larger than 2GB. 
ClipPlayer  manual embedded in the MiniBank is presented on the next pages.  
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7.6 EXE files playback (MiniBank format), ClipPlayer, RecordPlayer  

As it was mentioned before, one of the backup methods is MiniBank saving. This file format is also 
used for local USB or CD backup. In each case this format is used with a file player - RecordPlayer            
is included. This player software is also available through Start / Programs / RASplus menu of  
Windows system and directly from RASplus (chapter 8.1). 

Notice: The RecordPlayer software requires for proper operation at least Pentium III 800MHz 
 processor and DirectX library 8.0 or newer. ATI-chipset-based VGA card and at least 16MB 
 RAM are recommended. For best results 32-bit colour depth setting is recommended. In case 
 of display problems VGA board drivers upgrade or card may be necessary.  

Software start-up can be done either by double clicking on a backup file or by clicking the player icon 
in the main window of Start/Programs Windows menu. In the first case, playback of the “attached” 
video file starts automatically, in the second case, path to the backup file should be selected. 

Notice: It is strongly advised not to open more than one player at one time. 

 
Player window layout is presented below. 
 
 
 
 

  

Camera view window 

Watermark icon 

Playback position 
slider 

Display mode and 
setting icons 

Playback control icons 
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After software start-up camera images are loaded and pause mode is set. In order to start playback 
following icons should be used.  
 
 
 
 
 
 
 
 
 
 
In a lower right corner of the window, playback progress bar is located.  
 
 
Slider track length represents file playback length. Slider position represents current playback point. 
In order to change playback position, press the left mouse button and move the slider to the desired 
position.  
By default, 4x4 screen split is displayed. In order to select any channel for one channel display, just 
double click on its image in the split screen mode. Double click on one-channel display, restores the 
previous split screen mode. In order to change the split screen mode and to change the camera group 
within a given split screen, click on one of the following icons: 
 
 

  

 

 

 

 

The following icon          expands camera images to full screen view. 
In order to restore regular window size, the  ESC button should be pressed on PC keyboard. 
The following icon         in full-screen mode activates 2x digital zoom feature. In this mode, pressing 
and holding the left mouse button allows the user to explore the whole image. In order to restore the  
regular image size the Normal option should be selected. 

 
 

Frame back  Frame forward 

Forward playback 
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end 

Go to the file 
beginning 

Next camera 
group 

Previous 
camera group 
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The following icon clicking         opens copy, print and setup menu:  
- The first menu item - Save - allows for saving images as a still BITMAP file or saving a part of the 
file as another  EXE file (ClipPlayer). Saving rules are the same as described in chapters 7.2. 
- The second menu item - Print - allows for camera image printing on a system printer similarly to 
 printing described in chapter 7.3 .  
- The third menu item - Info - displays detailed file information   
 
 
 
 
 
 
 
 
 
 
- The fourth menu item - Image Processing - allows for digital image processing in full-screen 
display mode of one camera. Brightness, blur and sharpness filters are available.  
 
 
 
 
 
 
 
- The fifth menu item - Video Format - allows for VGA display mode selecting. In case images are 
displayed correctly, there is no need to change anything in this menu. Only when display problems 
occur (black camera windows, distorted image, colour squares displayed instead of camera images), 
the user should find the best mode by testing different settings..   
Following display modes are available: 
 
 
 
 
 
 
 
- Sixth menu position - Ustawienia OSD  allows for selecting data to be displayed superimposed on 
the camera picture during backup playback.  

- Seventh menu position - Anti-aliasing  allows for enabling filter preventing „shredding” the  edges 
of oblique objects during backup playback.  

- Eighth - Poka�  wprowadzony tekst allows for enabling the additional text data displaying during 
backup playback (if such data were copied too, check sub-chapter 7.5).  
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Text data are displayed only when viewing a single channel full-screen. 
 

 

 

 

 

 

 

 

 

 

 

 

As mentioned in sub-chapter 7.1, local recording of viewed video stream is possible. Recorded 
material can be played from HDD by RecordPlayer software, launched by the icon located in the 
main application window. Appearance and overall functionality is very similar to the already 
described ClipPlayer. 
The main difference between them is the possibility of converting the recordings located on the 
computer’s HDD and legible to DVR to other formats therefore allowing for exporting and playing 
them on other computers. Clicking the  icon allows for selecting one of two graphic formats for 
storing still frames and one of two formats for storing pictures (AVI or MiniBank). Creating video 
clips is similar to one described in chapters 7.4 and 7.5. 
Recordings are played back from the oldest to most recent ones. Player skips the recordings 
automatically.  
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8. SITE MAP FEATURE 

Map Editor allows the user to create site maps using uploaded images and predefined icons. 

In order to run the Map Editor module, go to the Start / Programs Windows menu and find the link 
to the application inside the RASplus group. 
 
 
 
 
8.1 Map Editor window 
 

 
 
 

 
 
 
 
 
 
In the View menu, the user can select which toolbar and menu should be displayed. 

Map edition workspace Edit toolbar Property menu 

Event action setting 
menu 

Icon menu 

Status bar 

SITE MAP FEATURE 
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8.2 Creating user site maps  

In order to start create a new map, new project must be started. Select New File in the File menu.  
It’s recommended to save the  project after starting using the Save as option. Later on, while editing 
is in progress, from time to time, saving changes by means of the Save command is also 
recommended. 
The Open… command opens a saved project.  
Instead of the  File menu, icons from the Edit toolbar can be used. 
 
8.3 Background image placing 

At the beginning of new map creation, background image should be selected and uploaded. Image 
should represent real site appearance. It could be any image made by graphic software saved as JPEG 
or BMP file.  

In order to imbed new background in a project, click on the           icon and select the desired image 

file. After selecting Open, background image is displayed in the edit window.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the Property menu, background properties can be set. 
Name - optional name 
Horizontal - background width expressed in pixels  

Vertical - background height expressed in pixels  
Background - background orientation 

SITE MAP FEATURE 
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8.4 Defining system components  

After imbedding the background all system components represented by icons should be distributed on 
it. To do that, all desired elements should be “dragged and dropped” from the icon menu onto the 
main edit window.  All system components are divided into 3 groups selected by means of tabs. The 
first tab contains camera icons, the second contains alarm output elements, the last one contains alarm 
input elements.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In order to adjust the layout of icons, special toolbar can be used.  
Description of each function description is displayed after mouse cursor is being placed above the 
toolbar icon.  
 
 
 
 
After placing a component into the project, its properties should be defined. In order to do that, click 
on the component icon and change the following settings in Property [ component type ] : 

In section General icon appearance and position is defined  
Name - component name, displayed when component is being selected in the map panel 

Description - additional component information is displayed in map panel  
Site information - predefined site information, allowing to fill most of  Equipment parameters 
automatically, selecting  Custom allows to fill all fields manually.  
Pre-defining site information is described in a further section of this chapter. 

Ratio - icon size ratio  

X, Y Coordinate - icon coordinates, this setting helps to place the icon on the background more 
precisely then using the mouse  

SITE MAP FEATURE 
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In the Equipment section relation between virtual component (icon) and real device (camera etc.) can 
be set. Most fields are filled automatically, unless the option Custom was selected in the menu Site 
information. 

IP Address  - IP address of the recorder to which the given component is connected 

User - user name that is used to login to a DVR while component using 

Password - user password 

Admin Port - port number which is used to control command and information sending 

Watch Port - port number which is used for video stream transmission  

Device no. - real device number, e.g. video channel number  

DVRDNS - domain name enabling / disabling feature  

 
In the section Event [ device type ] behaviour of a given component during various events can be 
defined 
 
Depending on the element type, following events can be selected and defined: 
Click - icon mouse click  
Motion Event - motion detected on a related video channel  
Video Loss - video loss detected on a related video channel  
Alarm-in Event - related alarm input activation 
 
Depending on the element type, following software action can be defined: 
Watch View Popup - popup window appears  
Switch on/off - given alarm output enabling / disabling  
 
Selecting of any action denotes its activation. Unchecked actions are ignored by the system. 
 
In order to avoid filling each property field manually while defining elements, saving data for further 
use can be done. In order to save site information choose Option / Site Information Setting… and 
create a new record by clicking Add.   
 
 

SITE MAP FEATURE 
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The following settings should be done in the displayed menu window: 
Site Name - any site name 

IP Address - DVR IP address 

Port... - connection port configuration 

Use DVRDNS - domain name service feature enabling / disabling 

User ID- user name for login 

Password - user password 

Confirm password - password confirmation 

No password - log in with no password  
 
In order to edit an existing site name information, select the item from the list and click Edit. 
In order to delete existing site name information, select an item from the list and click Remove 
 
8.5 Defining map links 

The RASplus software allows for managing complex systems by means of multi-level site maps. 
Thanks to multi-level maps the user has clear and easy access to any part of the monitored space.      
As an example of such a multi-level site map building maps can be given. Top level map gives a 
chance to select secondary maps of each floor and from it any camera can be selected.  

Return to the primary map is also possible thanks to links. 

In order to create multi-level maps separate primary and secondary maps should be made separately 
using the previously described rules. Then links to each maps should be defined 

For example, in a primary map the following icon         should be clicked. The link can be placed in 
any desired place of the background image.   

 
 
 

SITE MAP FEATURE 
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Now exact position and size of the link can be chosen.  

Name -  link description which is visible on a displayed map  

Image - link image selection  

link document - map file which the link refers to 

Ratio - link image ratio 

X, Y Coordinate - link coordinates, helping to place the icon in the background more precisely then 
using the mouse  

Horizontal - link width given in pixels 
Height - link height given in pixels 
Text Show - link name display disable - enable setting  
 

8.6 Defining component state indication  

The user is able to recognize the state of each component either thanks to small pictograms appearing 
on icons or thanks to icon colour changing.  

e.g. 
 
 
In order to enable colour indication, enter Option / Status Color Setting… and select Use colour. 
In the  displayed menu, the  user can select the desired colour for each event type: 
 

  
 

 Unplugged - component is not defined or no connection could be established  
 Event Off - component status is not checked  
 Irregular - component behaves abnormally 
 Video Loss - video loss of a particular channel 
 Motion - motion detected 
 Alarm In - alarm input activated  
 Alarm out - alarm out enabled 

 
 
 
8.7 Site name table 

Name of the destination where a given element comes from can be displayed as an IP address   e.g. 
83.12.234.2 or as a related name which can be more convenient for a user. 
Site names can be defined in Option / Name table… 
In the window, all defined IP addresses are displayed. Next to addresses there are editable fields 
where names can be typed in.  

SITE MAP FEATURE 
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SITE MAP FEATURE 

8.8 Pop-up camera duration time. 

As mentioned in sub-chapters 4.7.2 and 8.4 images from cameras may be displayed automatically as a 
pop-up window whenever an event associated with them occurs.  
Alarm window may be displayed either until its manual closing (or closing a given map) or for a 
limited amount of time. Display mode is determined by settings in Options / Popup Dwell Time 
 
 
 
 
 
 
 
 
 
 
 
 
Selecting Use Time Out causes the window to be closed after a defined time (in a box to the right) 
passes (unless an event for that channel occurs again)  
Selecting Display Remaining Time displays time left to closing the pop-up window superimposed 
on the picture from camera. 
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